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ОСНОВНЫЕ ХАРАКТЕРИСТИКИ ПРОГРАММЫ 

Пояснительная записка 

   Дополнительная общеобразовательная (общеразвивающая) программа 

«Основы 3D моделирования»,  далее  по тексту  - «программа», разработана на 

основе стандартных руководств к изучаемым в курсе компьютерных средств, в 

том числе программного обеспечения. Программа адаптирована исходя из 

существующих возможностей материально-технического обеспечения, личного 

педагогического опыта и в соответствии с основными нормативно-правовыми 

документами: 

- Конвенция о правах ребёнка; 

- Федеральный Закон РФ от 29.12.2012 г. №273 «Об образовании в 

Российской Федерации»;  

- Приказ Министерства образования и науки РФ от 27.07.2022 г. № 629 «Об 

утверждении порядка организации и осуществления образовательной 

деятельности по дополнительным общеобразовательным программам»;  

- Концепция развития дополнительного образования детей до 2030 года от 

31.03.2022 г. № 678-р. 

- Постановление Главного государственного санитарного врача Российской 

Федерации от 28.09.2020 г. № 28 "Об утверждении санитарных правил СП 2.4. 

3648-20 «Санитарно-эпидемиологические требования к организациям 

воспитания и обучения, отдыха и оздоровления детей и молодежи»  

- Постановление Правительства Кировской области от 20.07.2020 № 389-П 

«О внедрении системы персонифицированного финансирования 

дополнительного образования детей на территории Кировской области»  

- Распоряжение Министерства образования Кировской области от 

30.07.2020 № 835 «Об утверждении Правил персонифицированного 

финансирования дополнительного образования детей на территории Кировской 

области» (ред. от 07.09.2020 № 1046, от 22.09.2020 № 1104, от 28.09.2020 № 

1139)  

- Устав МКУ ДО «Станция юных туристов и техников» и материально – 

технических возможностей объединения. 

Основы 3D моделирования – одна из ступеней в освоении детьми 

компьютерных технологий.  

Адресат программы. Режим и формы занятий. 

Данная программа ориентирована на обучающихся 5-11-х классов в возрасте 11 

– 18 лет, уверенно освоивших основы работы с компьютером и 

заинтересованных в углубленном изучении компьютерных технологий. Срок 

реализации программы – 1 год.  Общее количество учебных часов – 144. 
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Программа имеет техническую направленность, решает задачи развития 

логического и алгоритмического мышления  школьников, а также их 

эстетического развития. Программа имеет стартовый уровень, даёт 

обучающимся знания и умения в следующих областях: 

 основы 3D моделирования объектов и сцен начальной и средней 

сложности; 

 основы текстурирования 3D объектов; 

 основы освещения и рендеринга 3D объектов и сцен. 

 В процессе освоения программы обучающиеся учатся самостоятельно 

анализировать поставленную им в общем виде задачу, намечать пути ее 

решения (строить алгоритм решения поставленной задачи), реализовывать 

созданный ими алгоритм на практике с использованием инструментария 

программы «Blender 3D».  

Под инструментарием в данном случае следует понимать встроенные в 

компьютерную программу возможности средств обработки информации для 

решения определенных задач (например, моделирования и текстурирования 

объектов). Обычно вызов этих возможностей осуществляется нажатием 

определенных кнопок или выбором определенных пунктов меню в 

компьютерных программах.  

В процессе освоения программы развивается мотивация обучающихся к 

собственному техническому развитию и профориентации, повышается культура 

их мышления, развиваются внимательность, настойчивость и 

целеустремленность. 

Новизна программы заключается в том, что она дает знания и навыки 

практического применения программы «Blender 3D», которые при 

определенном развитии могут быть использованы во «взрослой» 

профессиональной деятельности. 

Актуальность программы обусловлена высокой популярностью и 

наглядностью представления информации в 3D формате в образовательном 

процессе, в социальных сетях, а также высокой востребованностью 

профессионалов в области 3D моделирования на рынке труда. 

Педагогическая целесообразность обусловлена возможностью программы 

творческого развития и самореализации обучающихся, выявления их 

природных склонностей и становления  технического мышления. 

Отличительные особенности представленной программы: 

 личностно-деятельностный характер обучения, опирающийся на 

концепцию развивающего обучения; 

 комплексное и целостное представление обучающимися основ 3D 

моделирования; 
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 программа предполагает освоение базового инструментария программы 

«Blender 3D», при этом она предполагает плавный переход от освоения 

конкретного инструментария к пониманию общих принципов, 

существующих в данной деятельности. 

Цель программы: способствовать формированию и развитию творческих 

способностей и технического мышления, интеллектуального и духовного 

уровня обучающихся, а также процессу их социализации, профориентации 

средствами компьютерных технологий. 

Задачи программы: 

 Воспитательные – формирование личностных УУД. Программа способствует: 

 Раскрытию личностного потенциала обучающихся средних и старших 

классов – их любознательности и интереса к компьютерным технологиям, 

творческих задатков, познавательной активности и самостоятельности. 

 Воспитанию трудолюбия и ответственности за результаты своей 

деятельности. 

 Формированию мотивации успеха и достижения поставленной (в том 

числе и самостоятельно) цели, творческой самореализации в процессе 3D 

моделирования объектов и сцен окружающего или воображаемого 

обучаемыми мира. 

 Формированию навыков ценностного отношения к своему здоровью и 

здоровью окружающих - освоению и осмысленному соблюдению правил 

производительной и безопасной работы с компьютером. 

 Воспитанию нравственных основ поведения и общения с товарищами в 

коллективе. 

Развивающие – формирование метапредметных УУД. Программа способствует: 

Развитию регулятивных УУД 

 Формированию навыков управления процессом организации 

собственного труда: умению анализировать исходные условия, ставить 

достижимые цели, вырабатывать концепцию (алгоритм) достижения цели, 

предпринимать практические действия в направлении достижения цели, 

контролировать промежуточные результаты,   при необходимости вносить 

в трудовой процесс (а иногда в поставленные цели и выработанные 

алгоритмы ее достижения) необходимые корректировки. 

Развитию познавательных УУД: 
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 Умению искать недостающую информацию, а также оценивать и 

применять на практике найденную информацию; 

 Овладению начальными сведениями о сущности и особенностях явлений 

в окружающем мире (3D моделирование – отображение окружающего 

мира в соответствии с некоторыми правилами этого мира); 

 Овладению логическими действиями сравнения, анализа, синтеза, 

обобщения, классификации, умению видеть аналогии и причинно-

следственные связи путем построения непротиворечивых рассуждений; 

 Формированию понятий знаково-символических средств (схем 

алгоритмов, печатной документации) для решения учебных и 

практических задач. 

Развитию коммуникативных УУД: 

 Формированию умения слушать и слышать педагога и других 

обучающихся; 

 Выработке умения работать как индивидуально, так и при необходимости 

объединяться в проектные группы, иметь свое нравственно и логически 

обоснованное мнение, умению понимать и оценивать различные 

(отличные от собственных) мнения и при достаточной их нравственной и 

логической обоснованности корректировать свое. 

Образовательные задачи. Программа способствует решению следующих 

образовательных задач: 

 Овладению знаниями, умениями и навыками работы в графическом 3D  

редакторе; 

 Закреплению, расширению и углублению знаний школьных предметов 

посредством включения обучающихся в творческую практическую 

деятельность; 

 Ознакомлению с основами деятельности специалистов в области 3D 

моделирования – разработчиков ПО, инженеров и дизайнеров. 

Режим и формы занятий.  

Занятия проводятся 2 раза в неделю по 2 учебных часа в группах от 12 до 13 

человек. Расчасовка в учебно-тематическом плане может варьироваться в 

зависимости от скорости и качества усвоения обучающимися учебного 

материала. Тематика содержания может корректироваться в зависимости от 

целей и задач занятий. Обучение по программе очное.  
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Формы образовательного процесса. Основной организационной формой в ходе 

реализации программы является учебное занятие. Эта форма обеспечивает 

четкость и непрерывность процесса обучения, возможность сочетания 

фронтальных, групповых и индивидуальных форм обучения. 

Занятия проводятся по следующей схеме: 

 организация обучающихся; 

 актуализация, повторение ранее изученного материала; 

 изучение нового материала; 

 практическая работа; 

 рефлексия; 

 подведение итогов. 

Обязательным компонентом настоящей программы является охрана и 

укрепление физического и психологического здоровья детей. Выполнению 

этого положения способствуют: 

 контроль правильности положения осанки обучающихся при работе за 

компьютером; 

 разбиение занятия на две части с обязательным перерывом 5-10 минут; 

 использование удобной мебели (компьютерных столов, стульев) в 

процессе занятия; 

 использование ЖК мониторов с высокой разрешающей способностью; 

 благоприятная эмоциональная обстановка на занятиях в духе 

сотворчества, доброжелательного отношения, поддержки со стороны 

педагога и взаимоподдержки обучающихся; 

 создание «ситуации успеха» для всех детей на каждом занятии, в первую 

очередь для недостаточно подготовленных – необходимо дать им 

возможность чувствовать себя на равных со всеми. 

Характеристики среднего и старшего школьного возраста. Особенностью 

большинства обучающихся среднего и старшего возрастного звена является то, 

что они чаще заинтересованы в получении конкретного результата при 

выполнении учебных упражнений, чем в понимании сути этих упражнений, 

общих принципов работы программ и технологического процесса обработки 

изображений и видеофрагментов. Они обычно способны выполнить и даже 

запомнить алгоритм выполнения конкретных упражнений, но редко могут 

самостоятельно адаптировать известный алгоритм, если немного изменить 

условия упражнения. Однако признаком компетентности в реальной 

деятельности является умение самостоятельно решать возникающие 
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практические задачи на основе знания теории, общих принципов работы 

программ, конкретных инструментов и их особенностей. 

Поэтому можно выделить следующие этапы развития творческого 

потенциала, способностей и освоения программы обучающимися: 

 Умение понимать конкретные задачи по обработке 3D моделей и сцен  и 

применять конкретные инструменты для решения этих задач; 

 Умение классифицировать задачи и применяемые для их решения 

инструменты; 

 Умение одновременно видеть несколько задач, строить 

последовательность их решения и последовательно применять разные 

инструменты для выполнения построенного алгоритма; 

 Понимание сути возникающих задач, характерные особенности  и 

взаимосвязи применения изученных инструментов; 

 Понимание тесной связи теории и практики, появление интереса к 

дальнейшему развитию в области 3D моделирования (например, к 

анимации объектов и сцен, моделированию физического взаимодействия 

объектов). 

Формы деятельности обучающихся. Работы с компьютером могут проводиться 

в следующих формах:  

  демонстрационная - работу на компьютере выполняет педагог, а учащиеся 

наблюдают; 

  фронтальная - синхронная работа учащихся по освоению или 

закреплению материала под руководством педагога;  

  самостоятельная - выполнение самостоятельной работы на  компьютере.  

Учитель обеспечивает индивидуальный контроль за работой учащихся; 

  проектная – выполнение объемной работы самостоятельно на протяжении 

нескольких занятий. 

Для достижения более качественных и высоких учебно-воспитательных 

результатов используется совокупность методов и приёмов обучения:  

 словесные (объяснение, диалог);  

 наглядные (схемы, таблицы, компьютерные презентации, примеры 

готовых работ воспитанников, видеоуроки, книжные иллюстрации);  

 практические  (упражнения,  письменные  работы, 

практические  работы, творческие работы). 

Для определения результативности образовательного процесса и своевременной 

его корректировке проводится мониторинг, основными этапами которого 

являются: 
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 входной контроль; 

 текущий контроль; 

 итоговый контроль. 

Основными формами и методами контроля являются: 

 наблюдение за обучающимися; 

 анкетирование; 

 периодические устные опросы; 

 тестирование; 

 контрольные задания; 

 практические задания для самостоятельного выполнения; 

 анализ массива данных, полученных в процессе контроля 

образовательного процесса. 

Формы подведения итогов реализации программы: 

 миниконкурсы внутри учебной группы, содержащие теоретическую и 

практическую части; 

 выполнение промежуточных учебных заданий, в том числе комплексных; 

 выполнение итоговых работ по каждому блоку программы; 

 участие в конкурсах и выставках различного уровня. 

Механизм оценки результатов. Знания и умения учащихся отслеживаются 

индивидуально в ходе процесса обучения: 

 Теоретические знания – в виде бесед, опросов, периодического 

тестирования; 

 Практические навыки – в ходе выполнения работ; 

 Результат обучения – умение моделировать объекты и сцены начального 

и среднего уровня сложности в 3D редакторе Blender 3D, создание и 

защита собственных проектов.  

Предполагаемые результаты реализации программы 

Личностные результаты 

В результате реализации данной программы пробуждаются, раскрываются и 

развиваются творческие способности обучающихся и реализуется их 

личностный потенциал в области освоения компьютерных технологий 3D 

моделирования. Процесс развития личности идет по циклическому пути от 

мотива к осмыслению и постановке задач,  далее к освоению технологических 



10 

 

основ решения задач с последующим их практическим решением и, в 

результате - постановка более сложной задачи. 

Мотивация обучающихся проходит развитие от простого желания 

смоделировать простой 3D объект к желанию освоения все более сложных 

приемов моделирования объектов и сцен и, постепенно, к пониманию 

желательности освоения теоретических основ данной конкретной деятельности 

и освоению смежных с изучаемой областей деятельности.  

Все промежуточные этапы между мотивом и получением практического 

результата способствуют освоению знаний и навыков в области компьютерных 

технологий 3D моделирования, формированию самостоятельности, здорового 

образа жизни, познавательной активности и развития культуры мышления, 

интеграции знаний школьных предметов и практической деятельности, 

воспитанию культуры трудовой деятельности, общительности, трудолюбия и 

ответственности. 

Получение результата в решении простой задачи мотивирует учащихся к 

постановке себе более сложной задачи, формирует у них устойчивый интерес к 

более глубокому изучению и освоению включенных в программу  технологий. 

Метапредметные результаты. 

Освоение обучающимися универсальных способов интеллектуальной 

деятельности, применимых как в рамках образовательного процесса, так и в 

реальных жизненных ситуациях. 

В части регулятивных УУД - сформированность следующих умений: 

 принять учебную задачу или ситуацию; 

 выделить и сформулировать проблему; 

 составить план действий по решению проблемы; 

 планомерно и настойчиво работать для реализации принятого плана 

действий; 

 периодически осуществлять самоконтроль и оценку достигнутых 

результатов; 

 соблюдать правила культуры и безопасности трудового процесса. 

В части познавательных УУД – сформированность следующих умений: 

 осуществлять поиск информации и выполнять необходимую 

корректировку планов в ходе практической деятельности; 
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 осуществлять операции сравнения, анализа, синтеза, классификации, 

обобщения, видеть аналогии и причинно-следственные связи, строить 

логические рассуждения. 

В части коммуникативных УУД – сформированность следующих умений: 

 слушать и слышать педагога и других обучающихся, учитывать разные 

точки зрения, формулировать и аргументировать собственное мнение и 

позицию, умение корректировать свою позицию в случае обоснованности 

необходимости такой корректировки; 

 работать в группе – устанавливать рабочие отношения, интегрироваться в 

группу с сохранением собственной индивидуальности, продуктивно 

взаимодействовать со сверстниками и педагогом. 

Предметные результаты. 

По окончании освоения программы обучающиеся будут 

Знать: 

 базовый инструментарий компьютерной программы Blender 3D; 

 основы моделирования объектов и сцен начального и среднего уровня 

сложности; 

 основы создания процедурных и текстурных материалов; 

 основы установки освещения сцен; 

 основы настройки процесса рендеринга объектов и сцен. 

Уметь: 

 устанавливать и выполнять базовую настройку программы Blender 3D; 

 моделировать объекты и сцены, в том числе по чертежам; 

 создавать процедурные и текстурные  материалы для моделируемых 

объектов; 

 создавать финальные изображения объектов и сцен. 

Обучающиеся смогут получить опыт следующих эмоционально-

ценностных отношений: 

 интерес к развитию в сфере компьютерных технологий 3D моделирования 

и/или смежных областей; 

 убеждение в ценности расширения своего кругозора, познания 

окружающего мира и его закономерностей, проявление основ жизненно 

состоятельной методики  познания; 
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  чувство успеха и самореализация от успешно решенной задачи. 

Учебно-тематический план. 

Настоящий курс разбит на три больших блока, состоящих из нескольких частей. 

Каждый блок содержит теоретическую и практическую части. В начале и при 

окончании курса проводятся вступительное и заключительное занятия.  

№ 

п/п 
Наименование блока 

Количество часов 

Теория Практика Всего 

 
Вступительное занятие 

«Краткий обзор курса». 
2 0 2 

1. Блок «Моделирование» 

1.1 
Получение, установка и 

предварительная настройка 

программы "Blender 3D" 
1 1 2 

1.2 
Интерфейс программы "Blender 

3D". Базовые понятия и 

элементы "Blender 3D" 
1 1 2 

1.3 
Работа с объектами в Object 

Mode 
2 8 10 

1.4 
Редактирование объектов в Edit 

Mode 
3 9 12 

1.5 
Редактирование объектов в Edit 

Mode с использованием 

инструментов 
4 16 20 

1.6 
Модификаторы и их 

использование 
4 16 20 

1.7 Системы частиц 2 6 8 

1.8 
Завершение моделирования 

сцены 
- 10 10 

 Итого в блоке: 17 67 84 

2. Блок «Текстурирование» 

2.1 
Предварительная подготовка к 

текстурированию 
1 1 2 

2.2 
Создание простых материалов и 

присвоение их объекту 
2 6 8 

2.3 
Создание простых процедурных 

материалов 
4 8 12 

2.4 Основы использования текстур 4 8 10 

2.5 
Нанесение готовых 

изображений поверх материала 
1 3 6 

2.6 Использование Volumetric 1 3 4 
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2.7 Использование HDRI карт 1 1 2 

 Итого в блоке: 14 30 44 

3. Блок «Рендеринг» 

3.1 Создание и настройка камер 1 1 2 

3.2 
Создание и настройка 

источников света 
1 3 4 

3.3 
Рендер-движки Blender 3D, их 

настройка и использование 
2 4 6 

 Итого в блоке: 4 8 12 

 
Заключительное занятие 

«Подведение итогов курса» 
2 0 2 

 Итого: 39 105 144 

 

Содержание тем (блоков) программы. 

№ п/п Описание темы и практической работы 
Продолжи-

тельность  

 

Вступительное занятие «Введение в курс». 

 

Организационная информация. Обзор цели и задач курса. Обзор 

задач, решаемых программой "Blender 3D" и возможностей 

программы.  
К списку тем… 

2 

1. Блок «Моделирование» 

1.1 
Получение, установка и предварительная настройка 

программы "Blender 3D". 
2 

 

Обзор технических требований, предъявляемых к компьютеру и 

программной среде, для обеспечения комфортной работы с 

программой «Blender 3D». 

Варианты установки "Blender 3D" (переносная или инсталляция в 

систему). Инсталляция в систему и предварительная настройка 

"Blender 3D". 

Обзор интерфейса и предварительная настройка программы 

"Blender 3D". 

 
Перечень базовых настроек приведен в Приложении 1. 

 

Практика. Установка программы «Blender 3D» на компьютер и 

выполнение первоначальных настроек программы (подробнее в 

Приложении 2).  
К списку тем… 

 

Приложение_1_3D_Моделирование_Настройки.docx#Приложение_1_Базовые_настройки
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Моделирование_установка_и_настройка
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Моделирование_установка_и_настройка
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1.2 
Интерфейс программы "Blender 3D". Базовые понятия и 

элементы "Blender 3D" 
2 

 

Основные интерфейсные блоки программы.  

Понятие о трехмерном пространстве и координатных осях. 

3D курсор и основы управления им. 

Понятие об объектах и примитивах, создание примитивов. 

Понятие об Origin Point объекта и основы управления им. 

Основы управления положением сцены. 

Управление отображением вспомогательных элементов сцены. 

 
Перечень изучаемых команд приведен в Приложении 1  

 

Практика. Освоение операций управления сценой (подробнее в 

Приложении 2). 
К списку тем… 

 

1.3 Работа с объектами в Object Mode 10 

 

Создание новых объектов в Object Mode. Выделение объектов. 

Управление объектом в Object Mode. Вспомогательные элементы 

управления объектом. 

Избирательное управление объектом по осям. 

Понятие о Pivot Point,  настройка Transform Pivot Point. 

Дублирование объектов, в том числе со сдвигом по оси. 

Объединение нескольких объектов в один объект.  

Отражение изменений во вспомогательной панели. Применение 

изменений к объекту. 

Последовательная отмена и возврат выполненных действий. 

 
Перечень изучаемых команд приведен в Приложении 1 

 

Практика. Моделирование простых конструкций в Object Mode 

(подробнее в Приложении 2). 
К списку тем… 

 

1.4 Редактирование объектов в Edit Mode 12 

 

Переход в Edit Mode. 

Выделение вершин, ребер и граней. 

Перемещение, вращение, масштабирование элементов объектов в 

Edit Mode. Отсутствие изменений во вспомогательной панели. 

Выделение нескольких элементов, замкнутых контуров, всех 

элементов. Отмена всех выделений.  

Использование функции «Snap» («Магнит») при перемещении 

элементов объекта. 

Слияние элементов объекта с использованием функции «Merge». 

Понятие двойной геометрии в объекте и признаки ее наличия. 

Использование слияния элементов объекта для устранения двойной 

геометрии. 

Восстановление геометрии объекта с использованием команды 

 

Приложение_1_3D_Моделирование_Настройки.docx#Приложение_1_Управление_интерфейсом
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Моделирование_интерфейс
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Моделирование_интерфейс
Приложение_1_3D_Моделирование_Настройки.docx#Приложение_1_Команды_для_Object_Mode
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Моделирование_Object_Mode
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«Fill». 

Удаление/растворение элементов объектов, сохранение 

целостности геометрии при растворении элементов. 

Особенности создания объектов в Edit Mode. Невозможность 

простого разделения объектов после выхода из Edit Mode. 

Разделение ранее объединенных объектов.  

Поведение Origin Point в различных режимах.  

 
Перечень изучаемых команд приведен в Приложении 1 

 

Практика. Выполнение заданий на освоение и закрепление 

приемов и навыков работы в Edit Mode (подробнее в Приложении 2). 
К списку тем… 

1.5 
Редактирование объектов в Edit Mode с использованием 

инструментов 
20 

 

Инструменты как способ деструктивного изменения геометрии 

объекта. 

 

Инструмент Loop – создание дополнительной геометрии для 

объекта.  

 

Пропорциональное редактирование – пластичная деформация 

объектов.  

 

Инструмент Knife – создание разрезов на объекте. Выполнение 

сквозных разрезов и разрезов под точным углом в 0, 45 и 90 

градусов. 

 

Инструмент Extrude – выдавливание новой геометрии.  

 

Инструмент Inset – создание вставок внутри граней. 

 

Основы моделирования по чертежу. Добавление чертежа в проект 

и его настройка. 

 

Инструмент Spin - создание закругленных фрагментов деталей 

и/или тел вращения. 

 

Инструмент «Slide» - скольжение выделенных фрагментов 

(вершин, ребер, а также их групп) относительно соседних ребер.  

 

Инструмент «Bevel» - создание фасок (закруглений) для ребер и 

вершин.  

 

Шейдинг геометрии - визуальное сглаживание неровностей 

геометрии объекта.  

 

Приложение_1_3D_Моделирование_Настройки.docx#Приложение_1_Команды_для_Edit_Mode
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Моделирование_Edit_Mode
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Используемые настройки инструментов приведены в Приложении 1. 

 

Практика. Освоение и закрепление навыков применения 

инструментов в Edit Mode (подробнее в Приложении 2). 
К списку тем… 

1.6 Модификаторы и их использование 20 

 

Модификаторы как средство недеструктивного изменения 

геометрии объекта и создания новой геометрии. Добавление 

модификаторов и управление порядком их применения. 

 

Модификатор Bevel – создание фасок с возможностью их 

динамической коррекции в процессе моделирования. 

 

Модификатор Array  – размножение объекта вдоль одной или 

нескольких осей.  

 

Модификатор Mirror – отзеркаливание существующей 

геометрии относительно Origin Point или какого-либо стороннего 

объекта. 

 

Модификатор Solidify - придание толщины плоским объектам. 

 

Модификатор Displace - смещение частей поверхности 

относительно друг друга. 

  

Модификатор Boolean – выполнение логических операций над 

двумя объектами. 

 

Модификатор Simple Deform - скручивание или сворачивание 

объекта в кольцо. 

 
Используемые настройки модификаторов приведены в Приложении 1 

 

Практика. Освоение и закрепление навыков применения 

изученных модификаторов (подробнее в Приложении 2). 
К списку тем… 

 

1.7 Системы частиц 8 

 

Системы частиц -  расположение множества мелких объектов 

(трава, кусты, деревья, камни и т.п.)  на поверхности какого-либо 

объекта.  

 
Используемые настройки систем частиц приведены в Приложении 1 
 

Практика. Освоение и закрепление навыков применения систем 

частиц (подробнее в Приложении 2). 

 

 

Приложение_1_3D_Моделирование_Настройки.docx#Приложение_1_Инструменты_Edit_Mode
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Моделирование_Инструменты
Приложение_1_3D_Моделирование_Настройки.docx#Приложение_1_Модификаторы
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Моделирование_Модификаторы
Приложение_1_3D_Моделирование_Настройки.docx#Приложение_1_Системы_частиц
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Моделирование_Системы_Частиц
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К списку тем… 

1.8 Завершение моделирования сцены 10 

 

Практика. Закрепление изученного материала - моделирование и 

расположение дополнительных элементов сцены. Распределение 

объектов сцены в коллекции, соответствующие смысловым 

элементам сцены (подробнее в Приложении 2). 
К списку тем… 

 

 Итого (академических часов) 86 

2. Блок «Текстурирование» 

2.1 Предварительная подготовка к текстурированию  2 

 

Режим отображения сцены «Просмотр материалов» («Material 

Preview»). Подготовка рабочей среды «Blender 3D». 

Подключение Add-on’а «Node Wrangler». 

 
Действия по подготовке к текстурированию описаны в Приложении 1 
 

Практика. Выполнение изученных настроек рабочей среды 

(подробнее в Приложении 2). 
К списку тем… 

 

2.2 Создание простых материалов и присвоение их объекту 8 

 

Вкладка «Настройка материалов», создание нового материала для 

объекта. 

Представление материала в окне «Shader Editor» - понятие о 

нодах и нодовой системе. Ноды «Output -> Material Output» и «Shader 

-> Principled BSDF». 

Принципы сочетания нодов - правила соединения их входов и 

выходов. Грубые ошибки при соединении нодов, признак ошибки. 

Применение нескольких материалов к разным частям одного 

объекта. 

 
Создание и настройка материалов описаны в Приложении 1 

 

Практика. Создание материалов и их присвоение объектам 

сцены (подробнее в Приложении 2).  
К списку тем… 

 

2.3 Создание простых процедурных материалов 12 

 

Создание пятнистого материала с хаотичным расположением 

пятен. 

Создание вариативности цвета для групп объектов (например, 

объектов, созданных с применением модификатора Array). 

Настройка вариативности цвета с использованием режима Vertex 

Paint. 

Настройка контактных теней другого цвета 

 

 

Приложение_2_3D_Моделирование_%20Практические_работы.docx#Моделирование_Завершение
Приложение_1_3D_Моделирование_Настройки.docx#Приложение_1_Подготовка_к_текстурировани
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Текстурирование_Подготовка
Приложение_1_3D_Моделирование_Настройки.docx#Приложение_1_Простые_материалы
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Текстурирование_Простые_материалы
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Создание и настройка материалов описаны в Приложении 1 
 

Практика. Создание процедурных материалов для объектов 

сцены (подробнее в Приложении 2). 
К списку тем… 

 

2.4 Основы использования текстур 10 

 

Понятие о текстурах и принципах их использования.  

Понятие о UV-развертке объекта. Автоматическое и ручное 

создание UV-развертки. Подготовка сложных объектов к созданию 

UV-развертки – определение линий разрезов.  

Состав материала на основе текстур – текстуры Diffuse, Ambient 

Occlusion, Roughness, Specularity, Normal и Bump. 

Создание «вспомогательных» текстур в программе CrazyBump.  

 
Создание и настройка текстур описаны в Приложении 1 

 

Практика. Создание и наложение текстур на объекты сцены 

(подробнее в Приложении 2). 
К списку тем… 

 

2.5 Нанесение готовых изображений поверх материала 6 

 

Режим «Texture Paint» и область его применения – нанесение 

готовых изображений (например, эмблем или логотипов) поверх уже 

существующего материала. 

 
Нанесение готовых изображений описано в Приложении 1 
 

Практика. Нанесение готовых изображений поверх 

существующего материала (подробнее в Приложении 2). 
К списку тем… 

 

 

2.6 Создание «объемных» материалов 4 

 

Использование нода «Shader -> Principled Volume» для создания в 

сцене областей тумана или дыма. 

Управление распределением плотности  и цвета тумана внутри 

области. 

 
Создание и настройка объемных материалов описаны в Приложении 1 
 

Практика. Использование нода «Shader -> Principled Volume» 

(подробнее в Приложении 2). 
К списку тем… 

 

2.7 Использование HDRI карт 2 

 

Понятие об HDRI (High Dynamic Range Image) картах. 

Использование HDRI карты для создания фонового окружения 

сцены. 

 

 

Приложение_1_3D_Моделирование_Настройки.docx#Приложение_1_Процедурные_материалы
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Текстурирование_Процедурные_материалы
Приложение_1_3D_Моделирование_Настройки.docx#Приложение_1_Текстуры
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Текстурирование_Текстуры
Приложение_1_3D_Моделирование_Настройки.docx#Приложение_1_Нанесение_изображений
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Текстурирование_Нанесение_изображений
Приложение_1_3D_Моделирование_Настройки.docx#Приложение_1_Объемные_материалы
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Текстурирование_Объемные_материалы
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 Настройка HDRI карт описана в Приложении 1 
 

Практика. Использование HDRI карт для создания фона сцены 

(подробнее в Приложении 2). 
К списку тем… 

 Итого (академических часов) 44 

3. Блок «Рендеринг» 

3.1 Создание и настройка камер 2 

 

Назначение, создание и позиционирование камеры.  

Настройка соотношения сторон и размера изображения из 

камеры. 

Типы камер: перспективная и ортогональная. Настройка 

ортогональной камеры. 

  
Настройка камеры описана в Приложении 1 
 

Практика. Добавление и настройка ортогональной камеры 

(подробнее в Приложении 2). 
К списку тем… 

 

3.2 Создание и настройка источников света 4 

 

Общие принципы установки источников света для освещения 

сцены. Заполняющий, рисующий, моделирующий, контровой, 

фоновый свет. 

Создание и позиционирование источников света.  

Типы источников света: Point, Sun, Spot, Area (точечный, солнце, 

пятно, светящаяся область). 

Назначение и использование каждого типа источников света. 

 
Настройка источников света описана в Приложении 1 
 

Практика. Создание и расстановка источников света для сцены 

(подробнее в Приложении 2). 
К списку тем… 

 

3.3 
Рендер-движки Blender 3D, их настройка и 

использование 
6 

 

Обзор рендер-движков Eevee и Cycles, их достоинств и 

недостатков. 

Настройки рендер-движка Eevee. 

Настройки рендер-движка Cycles. 

Настройка шумоподавления в Cycles: 

 
Настройка рендер-движков и шумоподавления описана в Приложении 1 

 

Практика. Настройка рендер-движков, шумоподавления и 

выполнение финального рендера (подробнее в Приложении 2). 

 

Приложение_1_3D_Моделирование_Настройки.docx#Приложение_1_HDRI_карты
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Текстурирование_HDRI_карты
Приложение_1_3D_Моделирование_Настройки.docx#Приложение_1_Камеры
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Рендеринг_Камеры
Приложение_1_3D_Моделирование_Настройки.docx#Приложение_1_Свет
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Рендеринг_Свет
Приложение_1_3D_Моделирование_Настройки.docx#Приложение_1_Движки
Приложение_2_3D_Моделирование_%20Практические_работы.docx#Рендеринг_Движки
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К списку тем… 

 

Итого (академических часов) 12 

 Заключительное занятие курса. 

 

Подведение итогов курса и постановка новых целей.  
 

К списку тем… 

2 

 Итого (общая продолжительность курса, часов) 144ч. 
 

 

ОРГАНИЗАЦИОННО-ПЕДАГОГИЧЕСКИЕ УСЛОВИЯ  

Условия реализации программы 

Учебно-дидактические пособия. 

Дидактические пособия можно разделить на три группы: 

 Культурологические – памятка культуры поведения на занятиях 

объединения; 

 Алгоритмические – общие рекомендации по выполнению учебных 

заданий, примерные алгоритмы 3D моделирования и текстурирования; 

 Технологические – «общие требования к 3D модели», «перечень 

контрольных точек при оценке качества текстурирования», «общие 

рекомендации по созданию 3D сцен». 

Учебно-наглядные пособия. 

Описания последовательности моделирования в текстовой форме или в 

виде последовательности изображений этапов моделирования.  

Видеозаписи мастер-классов по компьютерной программе Blender 3D, 

находящиеся в свободном доступе в сети Интернет. 

Материально-техническое оснащение занятий. 

Материально-техническая база, оснащение и оформление в значительной мере 

определяют эффективность занятий и конечные результаты освоения 

обучающимися данной программы. 
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Для реализации программы имеются следующие материально-технические 

средства: 

 Компьютеры, оснащенные процессорами уровня минимум Intel Core2 

Quad (желательны Intel Core-i3, Core-i5), оперативной памятью объемом 

минимум 4 GB (желательно 16 GB), устройствами постоянной памяти 

HDD 500GB, (дополнительно желательны устройства SSD объемом 

минимум 120 GB в качестве системного диска), видеокартами с объемом 

памяти минимум 2 GB и шириной шины данных минимум 64 бит 

(желателен объем памяти от 4GB и шины данных 128 бит); 

 Мониторы современного уровня (либо хорошо откалиброванные ранее 

использованные мониторы);   

 Компьютерная сеть со скоростью минимум 100 Мбит/сек. 

 Доступ в Интернет со скоростью минимум 1 Мбит/сек (желательно 

100Мбит/сек). 

 Учебное помещение, соответствующее санитарным нормам по объему 

пространства и освещенности; 

 Компьютерные столы и стулья. 

 Проекционная аппаратура для наглядной демонстрации работы с 

изучаемой компьютерной программой Blender 3D. 

Методическое обеспечение. 

Программа построена так, чтобы охватить все основные  базовые возможности 

моделирования, текстурирования и рендеринга изучаемой компьютерной 

программы 3D моделирования Blender 3D и содержит большое количество 

примеров, иллюстрирующих применение изучаемого инструментария 

компьютерной программы. 

Образовательный процесс объединения предполагает: 

 отбор форм обучения; 

 методов и приемов обучения, способствующих успешному освоению 

обучающимися программы; 

 личностно-деятельностный характер обучения. 

Для успешности реализации программы и закрепления изученного материала 

используются следующие формы обучения: 

 практическое задание; 
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 комплексное практическое задание (практическое задание, для 

выполнения которого требуется применение знаний нескольких 

изученных ранее тем); 

 разбор выполнения практического задания. 

В процессе объяснения теоретических основ, положенных в основу изучаемой 

компьютерной программы Blender 3D и наблюдения за выполнением 

практических заданий и последующего разбора выполнения практического 

задания педагог замечает и впоследствии анализирует: 

 подход обучающихся к выполнению практических заданий; 

 трудности, возникающие у обучающихся при выполнении заданий, и то, 

как они преодолевают эти трудности; 

 вопросы, которые задают обучающиеся. 

Подход к усвоению теоретических основ, положенных в основу изучаемой 

компьютерной программы Blender 3D и выполнению практических заданий 

может быть формальным или творческим. 

При формальном подходе обучающийся не вдается в понимание 

глубинных принципов применения изучаемого инструментария и впоследствии 

применяет изученный инструментарий без попытки анализа особенностей 

данного конкретного объекта или сцены для моделирования и попытки выбора 

оптимального инструмента для решения задачи. Как следствие выбирается не 

самый эффективный инструмент и при его применении не используются все его 

возможности. 

При творческом подходе обучающийся заинтересован в более глубоком 

изучении и понимании принципов, заложенных в инструменты, особенностей 

задания, при которых эффективным будет использование того или иного 

инструмента или комплексное применение изученного инструментария. 

Обучающийся старается достичь наилучшего возможного результата, пусть 

даже поначалу за значительно большее время. 

Педагог должен ненавязчиво показывать преимущества творческого 

подхода и стимулировать переход обучающихся к творческому подходу в 

обучении и  выполнении практических заданий. Это может быть достигнуто 

при построении учебного процесса по принципу «от простого к сложному». В 

начале предлагаются задания, для выполнения которых достаточно формальных 

подходов. Потом предлагается упражнение, при выполнении которого 

формальный подход дает результат очевидно далекий от оптимального. Педагог  
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раскрывает разницу между формальным и творческим подходом и предлагает 

более совершенные способы решения поставленной задачи. 

ФОРМЫ АТТЕСТАЦИИ 

Аттестация обучающихся проводится после изучения каждого логически 

завершенного блока учебной программы, например, «Работа с объектами в 

Object Mode» или «Основы использования текстур», а также после завершения 

изучения каждого из трех блоков программы.  

Аттестация учащихся предусматривает проверку теоретической и практической 

подготовки учащихся в соответствии с требованиями настоящей программы и 

проводится в форме компьютерного теста по теоретической части и в форме 

выполнения контрольных практических заданий.  

ОЦЕНОЧНЫЕ МАТЕРИАЛЫ 

Для проверки теоретической подготовки учащихся было разработано WEB-

приложение для тестирования учащихся. Формат теста в целом аналогичен 

формату тестов международного сертификационного  центра «Pearson VUE». 

Вопросы теста составляются таким образом, чтобы проверить: 

 Понимание учащимися общих принципов функционирования и 

применения инструментов (или последовательности инструментов) 

изучаемой программы Blender 3D; 

 Умение настраивать и использовать конкретные инструменты; 

 Умение учащихся выбирать оптимальные инструменты для решения 

практических задач разных типов; 

Тест включает три типа вопросов: 

 Идентификация интерфейсных элементов изучаемой компьютерной 

программы; 

 Выбор единственного верного варианта решения описанной практической 

задачи; 

 Выбор нескольких верных вариантов решения описанной практической 

задачи; 

За ответ на каждый вопрос учащийся может набрать определенное количество 

баллов. Тест считается пройденным, если учащийся набрал количество баллов 

выше некоторого порогового значения (обычно в диапазоне 0,6 – 0,8 от 

максимально возможного количества баллов). 
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В процессе выполнения теста после ответа на каждый вопрос учащийся видит, 

правильно ли он ответил на вопрос теста. Если учащийся дал неверный или 

частично верный ответ, то правильный ответ показывается, но возможности 

изменить ответ тестирующая программа не предоставляет. Также показывается 

количество баллов, набранных учащимся за данный им ответ. 

Время на прохождение теста не ограничивается, практически прохождение 

теста занимает около 15-30 минут. Учащийся может пересдавать тест 

неограниченное количество раз, но не более одного раза за занятие. 

Примерные вопросы теста приведены в Приложении 3. 

Для проверки практических навыков учащихся им дается задание выполнить 

какое-либо задание на моделирование или текстурирование. Оценке подлежат 

следующие параметры: 

 Качество выполнения задания; 

 Скорость выполнения задания; 

 Оптимальность выбора инструментов для выполнения задания; 

 Для сложных заданий оценивается последовательность применения 

выбранных инструментов; 

 Уровень самостоятельности выполнения задания. 

Пример практического тестового задания приведен в Приложении 3. 

Критерии оценки выполнения практического задания 

Для первых четырех оцениваемых параметров разработка формальной 

методики оценки представляется проблематичной, поскольку 3D 

моделирование относится к разряду творческих работ, которые могут быть 

выполнены несколькими правильными способами. В целом следует обращать 

внимание на то, насколько учащийся может обосновать свой вариант 

выполнения задания: выбор инструментов и последовательности их 

применения, затраченное на выполнение задания время. 

Самостоятельность выполнения задания оценивается следующим образом: 

 Самостоятельная работа – 9 - 10 баллов; 

 Небольшая помощь педагога – 6 – 8 баллов 

 Постоянная помощь педагога – 3 – 5 баллов 

Полный аттестационный балл получается суммированием баллов, набранных 

учащимся за теоретическую и практическую части аттестации. Аттестация 

Приложение_3_примеры_тестов.docx#Примеры_вопросов_теста
Приложение_3_примеры_тестов.docx#Пример_практического_задания
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считается успешно пройденной, если учащийся набирает не менее 60-ти 

процентов от максимально возможного балла.  

 

Литература  для педагога. 

1. М.Н.Серова. Учебник-самоучитель по графическому редактору Blender 

3D. Издательство «Солон Пресс», 2021 год, 272 страницы. 

2. А.Прахов. Blender 3D-моделирование и анимация: руководство для 

начинающих. Издательство «БХВ-Петербург», 2009 год, 266 страниц. 

3. М.В.Терехов. Технология трехмерного моделирования в Blender 3D. 

Издательство «Флинта», 2018 год, 79 страниц. 

4. А.В.Аверченков. Технология трехмерного моделирования и 

текстурирования объектов в Blender 3D и 3D Max. Издательство 

«Флинта», 2019 год, 143 страницы. 

5. А.Прахов. Самоучитель Blender 2.7. Издательство «БХВ-Петербург», 2016 

год, 400 страниц. 

Интернет - ресурсы. 

1. https://docs.blender.org – онлайн документация по программе Blender 3D. 

2. https://online.kaino.ru/?acc=all – сайт онлайн университета «Кайно», 

бесплатные курсы «Blender Start» и «Wagon», преподаватель – Павел 

Голубев. 

3. https://www.youtube.com/@DmitriyViz/videos - Youtube канал @DmitriyViz. 

Видеоуроки по моделированию, текстурированию и анимации. 

4. https://www.youtube.com/@AndreySokolovRu/videos - Youtube канал Андрея 

Соколова. Видеоуроки по моделированию, текстурированию, системам 

частиц. 

5. https://www.youtube.com/watch?v=LGNj0_zVJh4&list=PLCqBVz1cD61AQ9bb_

rWCR9dsnK40Ms9FO – плейлист по модификаторам Blender 3D. 

Литература для обучающихся. 

1. М.В.Терехов. Технология трехмерного моделирования в Blender 3D. 

Издательство «Флинта», 2018 год, 79 страниц. 

https://docs.blender.org/
https://online.kaino.ru/?acc=all
https://www.youtube.com/@DmitriyViz/videos
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текстурирования объектов в Blender 3D и 3D Max. Издательство 
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Приложение 1  

Описание изучаемой в курсе функциональности программы «Blender 3D» 

Блок «Моделирование» 

Базовые настройки программы «Blender 3D» 

Окно настроек программы вызывается командой «Edit -> Preferences». Предварительно 

выполняются следующие настройки: 

 

 Русификация подсказок. Выполняется на  вкладке «Interface»: в разделе «Display» 

установить галочку «Tooltips», в разделе «Translation» в поле «Language» установить 

«Русский», в поле «Affect» установить галочку «Tooltips». 

 Подключение Add-on’ов. Выполняется на вкладке «Add-ons», следует установить 

Add-on’ы «Node Wrangler», «Copy Attributes Menu», «Archimesh». 

 Настройка рабочего пространства. Выполняется на вкладке «Navigation», следует 

установить галочку «Orbit Around Selection» и отключить галочку «Auto Perspective». 

 Системные настройки. Выполняется на вкладке «System», следует настроить 

ускорение рендер-движка Cycles (если видеокарта компьютера позволяет это сделать) 

в разделе «Cycles Render Devices» в поле «CUDA» установить галочку напротив 

названия видеокарты компьютера, а также количество возможных отмен в поле «Undo 

Steps» (чем больше, тем лучше, но настройка большого количества отмен загружает 

оперативную память компьютера, оптимально значение в диапазоне 60 - 100). 

Управление интерфейсом программы «Blender 3D» 

Показ/сокрытие панели инструментов – «T». 

Показ/сокрытие дополнительной навигационной панели – «N». 

Создание нового примитива – «Shift+A -> Mesh». 

 

3D курсор и основы управления им: 

 установка в произвольную позицию – «Shift + RClick»; 

 возврат к началу координат «Shift+S -> Cursor to World Origin». 

 

Origin Point и основы управления им: 

 перемещение геометрии объекта к Origin Point (RClick -> Set Origin -> Geometry to 

Origin); 
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 перемещение Origin Point к геометрии объекта (RClick -> Set Origin -> Origin to 

Geometry).  

 

Управление сценой: 

 перемещение – «Shift + нажатие колесика»; 

 вращение - нажатие колесика; 

 приближение/удаление сцены - вращение колесика. 

 вид справа – «1» на Numpad, слева – «Ctrl+1»; 

 вид спереди – «3» на Numpad, снизу - «Ctrl+3»; 

 вид сверху – «7» на Numpad, снизу - «Ctrl+7»; 

 переключение между режимами отображения сцены – «Z»; 

 отображение вспомогательных элементов сцены – кнопка «Show Overlays». 

 

Команды для работы в «Object Mode» 

Вызов меню панели инструментов – «T». 

Создание новых примитивов в Object Mode – «Shift+A -> Mesh». 

Перемещение объекта – «G», перемещение по оси – «G[название_оси]», например «GZ», 

перемещение по оси на N единиц - «G[название_оси][N]», например «GX3». 

Вращение объекта – «R», вращение вокруг оси – «R[название_оси]», например «RX», 

вращение вокруг оси на N градусов - «R[название_оси][N]», например «RZ45». 

Масштабирование объекта – «S», масштабирование по оси – «S[название_оси]», 

например «SY», масштабирование по оси в N раз - «S[название_оси][N]», например «SY2». 

Исключение перемещения по какой-либо оси – «G[Shift+исключаемая_ось]», например 

«G Shift+X». 

Исключение масштабирования по какой-либо оси – «S[Shift+исключаемая_ось]», 

например «S Shift+Z». 

Включение вспомогательных элементов управления для объекта - кнопка «Show Gizmo», 

раздел «Default». 

Настройка Transform Pivot Point - наклоненная «восьмерочка» с точкой по центру в 

верхней части окна программы. Возможные настройки: 

 Median Point – центральная точка между выделенными объектами; 

 Individual Origins – каждый объект будет вращаться/масштабироваться относительно 

своего центра; 

 3D Cursor – вся группа объектов вращается/масштабируется относительно 3D 

курсора; 

 Active Element - вся группа объектов вращается/масштабируется относительно 

последнего выделенного объекта. 

Дублирование объектов – «Shift+D», дублирование со сдвигом по оси – «Shift+D 

[ось_сдвига]», например «Shift+D X». 

Объединение нескольких объектов в один – «Ctrl+J».  

Применение изменений к объекту – «Ctrl+A» с последующим выбором типа 

применяемых изменений. 

Последовательная отмена выполненных действий – «Ctrl+Z». 

Последовательный повтор отмененных действий «Ctrl+Shift+Z». 
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Команды редактирования в «Edit Mode» 

Переход в Edit Mode – «Tab». 

Режимы выделения вершин, ребер и граней  - клавиши «1», «2» и «3». 

Выделение нескольких элементов (Shift), выделение замкнутых контуров (Alt), выделение 

всех элементов - «A». Отмена всех выделений - двойное нажатие «AA».  

 

Перемещение, вращение, масштабирование выделенных элементов объектов – те же 

команды, что и в Object Mode. 

 

Использование функции «Snap» («Магнит») при перемещении элементов объекта. 

 

 

Настройки «Vertex», «Edge» и «Face» определяют, к каким 

элементам «целевого» объекта будет выполняться 

примагничивание. 

Настройки «Closest», «Center», «Median» и «Active» 

определяют, какая точка перемещаемого/вращаемого/ 

масштабируемого объекта (элемента объекта) будет 

примагничиваться. 

Настройки «Move», «Rotate» и «Scale» определяют, при 

каких действиях будет выполняться примагничивание. 

Настройка «Align Rotation to Target» указывает, что 

перемещаемый объект будет копировать поворот той части 

«целевого» объекта, к которой выполняется примагничивание. 

Настройка «Project onto Self» доступна только в «Edit Mode» 

и указывает, что одни элементы объекта могут 

примагничиваться к другим элементам того же самого объекта. 

 

Слияние элементов объекта - «M». Возможные опции: 

 At First – слияние к первому выделенному элементу; 

 At Last - слияние к последнему выделенному элементу; 

 At Center - слияние к середине мысленной фигуры из выделенных элементов; 

 By Distance – выделенные элементы сливаются, если расстояние между ними 

меньше указанного. 

 

Восстановление геометрии объекта с использованием команды «Fill» - «F». Применяется 

для соединения несвязанных точек и для восстановления граней минимум по трем точкам, но 

иногда, в случае однозначно определяемой грани, может применяться при выделении только 

одного ребра.  

Удаление/растворение элементов объектов – «X».  При использовании опций группы 

«Dissolve» предпринимается попытка сохранения целостности геометрии объекта. 

 

Разделение ранее объединенных объектов: 

 выделить объединенный объект; 

 перейти в Edit Mode, активировать команду «Separate» («P»); 

 выбрать пункт «By Loose Paths». 
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Команды инструментов, используемых в Edit Mode 

Инструмент Loop (Петля) – для вызова инструмента используется комбинация «Ctrl+R». 

Петля может быть создана в случае наличия строго четырех ребер у грани.  

Следует подвести указатель мыши к ребру, перпендикулярно которому должна быть 

построена петля. После появления петли выполнить щелчок левой кнопкой  мыши. 

Количество петель может быть настроено вращением колесика мыши. Количество 

создаваемых петель отображается в левом нижнем углу окна программы. Положение петель 

настраивается движением мыши. После выбора количества петель и их расположения, 

выполнить щелчок левой кнопкой мыши. 

Если петли должны быть расположены строго по центру, но были сдвинуты случайным 

движением мыши, то следует выполнить щелчок правой кнопкой мыши – это расположит 

петли строго по центру. 

Если петли создаются на трапецеидальных гранях, их можно выровнять по одной из 

боковых сторон нажатием клавиш «E» и «F». 

 

Пропорциональное редактирование включается клавишей «O» или одноименной 

кнопкой в верхней части окна программы. 

 

 

Для применения инструмента предварительно 

следует выделить какой-либо элемент объекта, 

после чего вызвать команду перемещения, 

вращения или масштабирования. Вокруг 

выделенного элемента объекта появится круг. 

Операция выполняется над всей геометрией, 

попавшей в круг. Управление областью применения 

операции (изменение размера круга) выполняется 

вращением колесика мыши.  

Тип пропорционального редактирования 

настраивается выбором из выпадающего списка 

кнопки пропорционального редактирования. 

 

Инструмент Knife (Нож). Вызывается нажатием кнопки «K». Разрез выполняется 

перпендикулярно плоскости экрана, т.е. если объект отображается под углом, то плоскость 

разреза не будет перпендикулярна к объекту. 

Инструмент применяется в следующем порядке: установить курсор, нажать левую кнопку, 

провести линию разреза, в конце линии снова нажать левую кнопку. 

Чтобы сделать сквозной разрез (через весь объект, а не только по видимым граням), 

следует после «K» нажать клавишу «Z». 

Для разрезов под 0, 45, 90 градусов  следует после «K» нажать «C». 

Например, «K -> Z -> C» позволит сделать сквозной разрез под 0, 45 или 90 градусов. 

 
Инструмент Extrude (Выдавливание) – вызывается нажатием клавиши «E». 

В случае выделения только одной грани выдавливание выполняется по нормали к этой 

грани. 
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В случае, если следует выполнить одновременное выдавливание нескольких граней, 

следует использовать комбинацию «Alt+E», после чего выбрать «Extrude Faces Along 

Normals» или «Extrude Individual Faces». В первом случае при выделении смежных граней, 

расположенных под углом, выдавленные грани тоже будут смежными, во втором – 

распадутся на несколько «столбиков».  

В случае, если инструмент был вызван и выдавливание началось, но было отменено 

нажатием клавиши «ESC», будет создана двойная геометрия. Чтобы избежать этого, после 

нажатия «ESC» следует выполнить отмену операции нажатием «Ctrl+Z».  

 

Инструмент Inset (Вставка) – создание вставок внутри граней. Вызывается нажатием 

клавиши «I». Для независимого одновременного создания вставок на нескольких выделенных 

гранях используется двойное нажатие «I». Если следует выполнить Inset только от граней, за 

которыми есть продолжение геометрии, используется последовательность «I -> B». 

 

Инструмент Spin (Вращение) - создание закругленных фрагментов деталей и/или тел 

вращения. Инструмент работает в плоскости экрана относительно 3D-курсора. 

По умолчанию для инструмента отсутствует комбинация клавиш и он  включается из 

панели инструментов. В Blender до версии 2.8 для вызова инструмента использовалась 

комбинация «Alt+R», в версии 2.8 и последующих shortcut для инструмента (обычно 

«Alt+R») следует назначать вручную (правый клик по кнопке инструмента -> Assign 

Shortcut).  

 

Инструмент «Slide» (Скольжение) - перемещение выделенных фрагментов (вершин, 

ребер, а также их групп) в Edit Mode относительно соседних ребер, которые выступают как 

направляющие для скольжения. Инструмент вызывается двойным нажатием «G G». 

 Если скольжение должно быть выполнено за пределы направляющих ребер, следует 

выполнить небольшое скольжение по ребрам, после чего нажать «Alt». После этого 

направляющие будут продолжены за пределы ребер. 

 

Инструмент «Bevel» (Фаска) - создание фасок. Вызов для ребер (Ctrl + B) и для вершин 

(Shift + Ctrl + B). Плавность фаски настраивается вращением колесика мышки. 

В случае, если объект редактировался в Object Mode и изменения не были применены, 

фаска получится неравномерной. 

При применении инструмента возникают проблемы (обычно фаска просто не создается) в 

случае наличия в объекте двойной геометрии. 

 
Шейдинг геометрии – сглаживание ребер при отображении объекта. Включается 

щелчком правой кнопки мышки на объекте с последующим выбором пункта «Shade 

Smooth». Используется для визуального сглаживания неровностей геометрии. 

Какие ребра должны сглаживаться настраивается, используется вкладка «Context» 

(зеленый треугольник). Настройка выполняется в параметре «Normals -> Auto Smooth». 

Сглаживаться будут те ребра, дополнительный угол между гранями в которых меньше 

величины Angle. 

Отмена сглаживания выполняется правым щелчком мышки на объекте с последующим 

выбором пункта «Shade Flat». 
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Модификаторы и их базовые настройки 

Элементы управления, общие для всех модификаторов: 

 

 

 Верхняя красная стрелка указывает на строку 

элементов управления, общих для всех 

модификаторов. 

 Нижняя синяя стрелка указывает на вкладку 

модификаторов. 

 

Кнопки строки управления слева направо: 

 

 Сворачивание настроек модификатора и иконка модификатора; 

 Название модификатора. Назначается автоматически, может быть изменено для 

присвоения более осмысленного названия; 

 Кнопка включения/отключения отображения сетки в соответствии с действием 

модификатора. Например, если при выключенной кнопке применить режим 

редактирования к объекту, к которому применен модификатор «Array», то сетка 

отобразится только для исходного объекта, но не для созданных модификатором 

копий. При нажатой кнопке сетка отобразится для исходного объекта и всех его 

копий. Тем не менее, редактировать можно будет только исходный объект. 

 Кнопка включения/отключения отображения действия модификатора в режиме 

редактирования. Например, если выключить эту кнопку, то при переводе объекта с 

примененным к нему модификатором «Array» в режим редактирования, все 

созданные модификатором копии объекта отображаться не будут. Если кнопку 

включить, то все копии в режиме редактирования будут отображаться. Тем не 

менее, их редактирование будет все равно невозможно). 

 Кнопка включения/отключения отображения результатов действия модификатора 

во вьюпорте. При отключенной кнопке действие модификатора отображаться не 

будет как в Edit Mode, так и в Object Mode. Например, часто бывает полезно 

временно отключить отображение действия модификатора «Subdivision Surface», 

чтобы либо увидеть сетку редактируемого объекта, либо сделать сетку менее 

частой. 

 Кнопка включения/отключения при рендере объекта. 

 Кнопка вызова меню применения, дублирования и перемещения модификатора в 

стеке модификаторов объекта. 

 Кнопка удаления модификатора из стека модификаторов объекта. 

 Кнопка для произвольного перемещения модификатора в стеке модификаторов 

объекта. 

 

Модификатор Bevel – создание фасок с возможностью их динамической коррекции в 

процессе моделирования. 

 

Основные настройки модификатора: 
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 Amount - настройка размера фаски; 

 Segments - плавность скругления; 

 Clamp Overlap - исключение перекрытия фасок; 

 Limit Method – выбор элементов объекта, к которым будет применен 

модификатор. 

o None – применение ко всем элементам; 

o Weight – применение только к элементам с ненулевым весом. Вес элемента 

(от 0 до 1) задается в окне дополнительного меню в параметре «Item -> 

Verticies Data (или Edges Data) -> Mean Bevel Weight»; 

o Angle – применение к элементам, дополнительный угол между которыми 

больше, чем указанный в параметре «Angle». 

 

Модификатор Array  – размножение объекта вдоль одной или нескольких осей.  

 

Основные настройки модификатора: 

 Fit Type – способ определения количества копий: 

o Fixed Count – явно заданное значение в параметре «Count» ; 

o Fit Length – заполнение объектами заданного расстояния, указанного в 

параметре «Length»; 

o Fit Curve - заполнение объектами указанной в параметре «Curve» кривой; 

 Relative Offset -> Factor – расстояние между копиями по осям координат, за 

единицу измерения принято само значение длины объекта по оси; 

 Constant Offset -> Distance – фиксированное значение расстояния между копиями; 

 Caps – объекты, добавляемый в начало и конец массива; 

o First Cap – объект, добавляемый в начало массива; 

o Last Cap - объект, добавляемый в начало массива. 

 

Модификатор Mirror – отзеркаливание существующей геометрии относительно Origin 

Point или какого-либо стороннего объекта. 

 

Основные настройки модификатора: 

 Axis – оси, вдоль которых выполняется отражение объекта; 

 Mirror Object – сторонний объект, относительно которого отражается объект с 

модифифкатором; 

 Clipping – настройка, устраняющая возникновение перекрытия частей отражаемого 

объекта. 

 Merge – расстояние между объектом и его отражением, начиная с которого объект 

и отражение сливаются в один объект. 

 

Модификатор Solidify - придание толщины плоским объектам. 

 

Для корректной настройки модификатора следует: 

 предварительно применить к нему изменения масштабирования, выполненные в 

Object Mode; 

 проверить ориентацию граней объекта 

o включить настройку «Show Overlays -> Face Orientation»; 
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o если грани ориентированы в разные стороны, выполнить команду «Alt+N -> 

Recalculate Outside» или «Alt+N -> Recalculate Inside». 

 

Основные настройки модификатора: 

 Thickness – толщина объекта; 

 Even Thickness – выравнивание толщины объекта по всей его поверхности. 

 

Модификатор Displace - смещение частей поверхности объекта относительно друг друга 

в зависимости от яркости наложенной на объект текстуры. 

  

Для успешного применения модификатора необходимо наличие достаточного количества 

геометрии. При недостатке геометрии ее следует предварительно создать. 

 

Основные настройки модификатора: 

 Texture -  накладываемая текстура, от яркости ее участков зависит сила сдвига 

соответствующего участка поверхности объекта. Если текстура еще не была 

создана, ее можно создать, нажав кнопку «New Texture» и настроить на вкладке 

текстур; 

 Strength – сила действия модификатора; 

 Direction – направление, в котором будеи выполняться смещение граней объекта; 

 Space – пространство координат, используемое модификатором. Доступный выбор 

– глобальное или локальное; 

 Vertex Group – карта распределения весов, созданная для объекта в режиме Weight 

Paint. Модификатор работает в полную силу выполненных настроек на участках с 

максимальным весом, на участках с меньшим весом сила воздействия 

модификатора уменьшается пропорционально уменьшению веса. 

 

Модификатор Boolean – выполнение логических операций с двумя объектами. 

 

Основные настройки модификатора: 

 Способ применения: 

o Intersect – пересечение объектов; 

o Union – объединение объектов; 

o Difference – разность объектов. 

 Operand Type – с каким типом объекта будет выполняться логическая операция: с 

объектом или коллекцией; 

 Object (Collection) – второй операнд логической операции; 

 Solver – применяемый для выполнения операции алгоритм; 

o Fast – упрощенный и более быстрый метод, применяемый в случае, если 

сетка первого объекта не имеет перекрытий; 

o Exact – более точный и медленный метод, применяемый, если первый 

объект имеет перекрывающуюся сетку; 

 Self – устанавливается, имеет самопересечения. 

 

Модификатор Simple Deform – простые деформации объекта, в курсе рассматривается 

случай скручивания или сворачивания объекта в кольцо. 



34 

 

 

Перед применением модификатора следует убедиться, что объект имеет достаточно 

геометрии для применения модификатора. Если геометрии недостаточно – ее следует 

предварительно создать (возможно, предварительным применением модификатора Array). 

Необходимость предварительного создания дополнительной геометрии для объекта. По 

умолчанию скручивание объекта может быть выполнено только вокруг оси Z, а сам объект 

должен быть вытянут вдоль оси X. 

 

Основные настройки модификатора: 

 

 Тип деформации – для выполнения задания курса следует выбирать «Bend»; 

 Angle – угол скручивания; 

 Axis - ось, вокруг которой выполняется скручивание; 

 

Системы частиц и их базовые настройки 

В процессе подготовки объекта или коллекции объектов, используемых как частицы, 

следует обратить внимание на расположение их Origin Point.  

Также следует указать значения «+Z» в «Настройки объекта (оранжевый квадратик) -> 

Relations -> Tracking Axis» для расположения частиц перпендикулярно поверхности 

базового объекта. 

 

Базовые настройки системы частиц типа «Hair»: 

 

 Emission -> Number - задает количество волос (частиц на поверхности); 

 Emission -> Seed - задает вариант случайного распределения частиц; 

 Emission -> Hair Length – задает длину волоса, может быть использован для 

настройки высоты частиц; 

 Render -> Render As – служит для выбора источника частиц (объект или коллекция); 

 Render -> Scale – служит для масштабирования размера частиц; 

 Render -> Scale Random – служит для случайного масштабирования размера частиц; 

 Группа настроек Rotation служит для поворота частиц и задания случайности этого 

поворота вокруг своей оси; 

 Vertex Group -> Dencity – карта распределения весов, ранее созданная в режиме 

«Weight Paint» 

 

Блок «Текстурирование» 

Предварительная подготовка к текстурированию 

При текстурировании используется отображение сцены в режиме предпросмотра 

материалов. В этом режиме вокруг сцены располагается окружение, освещающее сцену, что 

позволяет рассмотреть материалы объектов сцены при различном освещении. 

 

Режим предпросмотра материалов включается кнопкой «Отображать в режиме 

предпросмотра материалов», настройки режима отображаются при нажатии стрелки вниз 

справа от кнопок переключения режимов отображения сцены.  
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Тип окружения может быть выбран при нажатии на круглую картинку окружения. 

 

Часто используемые настройки: 

 Rotation – поворачивает окружение вокруг моделируемой сцены; 

 Strength – регулирует яркость окружения. 

 

Наиболее удобное рабочее пространство достигается разделением рабочей области 

программы на два окна, одно из которых находится в режиме предпросмотра материалов, а 

второе – в режиме «Shader Editor». 

 

 

Кнопка переключения в 

режим предпросмотра 

материалов 

Настройки окружения 

сцены. 
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Add-on «Node Wrangler» подключается в «Edit -> Prefences -> Add-ons», в строке поиска 

достаточно набрать «Node» 

 
 

 

Создание простых материалов и присвоение их объекту 

Вкладка «Настройка материалов», создание нового материала для объекта. 

 

Представление материала в окне «Shader Editor» - понятие о нодах и нодовой системе. 

Ноды «Output -> Material Output» и «Shader -> Principled BSDF». 

 

Принципы сочетания нодов с использованием их входов и выходов на примере создания 

цветного блестящего материала (ноды «Diffuse BSDF», «Glossy BSDF» и «Mix Shader»). 

Понятие о правилах соединения входов и выходов нодов.  
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Признак возникновения грубой ошибки в процессе соединения нодов – окраска объекта в 

розово-фиолетовый цвет. 

 

 
 

Нод «Principled BSDF» и его основные параметры: 

 

 Base Color – цвет поверхности объекта; 

 Subsurface Color и сила проявления этого цвета Subsurface. При увеличении 

параметра Subsurface этот цвет начинает перекрывать цвет поверхности, если параметр 
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Metallic имеет малые значения. При увеличении параметра Metallic начинает 

преобладать цвет поверхности, и при Metallic равном «1» цвет поверхности полностью 

перекрывает цвет под поверхностью; 

 Metallic – имитирует «металлический блеск»; 

 Specular - сила отражения света по краям. При высоких значениях шероховатости 

Roughness параметр Specular проявляется незначительно, для гладких поверхностей 

Specular проявляется тем сильнее, чем более гладкой становится поверхность. В 

большинстве случаев работает правило «Specular есть инвертированный Roghness и 

наоборот»; 

 Roughness – шероховатость поверхности, имеются в виду микрошероховатости, при 

нулевом значении поверхность превращается в зеркальную; 

 Sheen - бархатистость («огибание» объекта светом); 

 настройка прозрачности материала: 

o предварительная настройка рендер-движка Eevee (Настройки рендера -> 

Галочка «Screen Space Refraction -> Refraction»); 

o предварительная настройка материала (Настройки материала -> «Settings -> 

Blend Mode -> Alpha blend» и Настройки материала -> «Settings -> Screen 

Space Refraction»); 

o настройка «Transmission (Прозрачность)» нода «Principled BSDF»; 

o настройка «IOR (Коэффициент преломления)» нода «Principled BSDF»; 

 Emission - свечение; 

 Emission Strength - сила свечения. 

 

Применение нескольких материалов к разным частям одного объекта: 

 

 Создание нового материала на вкладке материалов; 

 Перевод объекта в Edit Mode; 

 Выделение граней объекта, к которым должен быть применен вновь созданный 

материал; 

 Выбор вновь созданного материала на вкладке материалов; 

 Присвоение выделенным граням вновь созданного материала нажатием кнопки 

«Assign» на вкладке материалов; 

 Настройка вновь созданного материала.  

 

Создание простых процедурных материалов 

Создание пятнистого материала с хаотичным расположением пятен. 

 

Новые ноды, используемые при создании материала, и их краткое описание: 

 Texture -> Noise Texture – генерирует текстуру с хаотичным распределением 

яркостей; 

 Converter -> ColorRamp – преобразует непрерывный диапазон яркостей текстуры в 

черный и белый цвета (или фиксированный набор цветов); 

 Color -> MixRGB – предоставляет возможность смешивания двух цветов по 

определенным правилам. 
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Алгоритм создания материала: 

 Добавить в материал нод «Color -> MixRGB», соединить его выход «Color» и входом 

«Base Color» нода «Principled BSDF». Выбрать цвета для пятнистого материала; 

 Добавить в материал нод «Converter -> ColorRamp», соединить его выход «Color» и 

входом «Factor» нода «MixRGB»; 

 Добавить в материал нод «Texture -> Noise Texture», соединить его выход «Factor» и 

входом «Factor» нода «ColorRamp»; 

 Выделить нод «Noise Texture» и нажатием «Cntrl+T» добавить ноды «Vector -> 

Mapping» и «Input -> Texture Coordinate». Удалить связь между добавленными 

нодами и установить связь между выходом «Object» нода «Texture Coordinate» и 

входом «Vector» нода «Mapping»; 

 Настроить размер и резкость пятен движением ползунков в ноде «ColorRamp»; 

 Настроить положение пятен и их размер, изменяя настройки в ноде «Mapping». 

 

Создание вариативности цвета для групп объектов (например, объектов, созданных с 

применением модификатора Array). 

 

Новые ноды, используемые при создании материала, и их краткое описание: 

 Input -> Object Info – сводная информация об объекте 

 

Алгоритм создания материала: 

 Предварительная подготовка объекта: 

o Выделить объект и применить к нему стандартный материал; 

o Применить к объекту модификаторы в последовательности «сверху вниз»; 

o Перейти в режим редактирования, выделить все; 

o Разделить объекты – нажать «P» и выбрать «By LooseParts»; 

 Создание материала: 

o Добавить нод «Color -> MixRGB», соединить его выход «Color» с входом 

«Base Color» нода «Principle BSDF», задать два цвета; 

o Добавить нод «Input -> Object Info», соединить его выход «Random» с входом 

«Factor» нода «MixRGB»; 

o Можно попробовать разные режимы наложения в ноде «MixRGB». 

 

Настройка вариативности цвета с использованием режима Vertex Paint. 

 

Применяется для раскраски объекта двумя цветами (и промежуточными между ними) с 

геометрически нечеткой границей между цветами.  

 

Новые ноды, используемые при создании материала, и их краткое описание: 

 Input -> Vertex Color – черно-белая карта распределения цветов 

 

Алгоритм создания материала: 

 Подготовка поверхности объекта: 

o Создать для поверхности дополнительную геометрию; 

 Создание маски в режиме Vertex Paint: 

o Перейти в Solid Mode; 
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o Перейти в режим Vertex Paint; 

o Выполнить раскраску поверхности объекта градациями серого. 

 Создание и настройка материала: 

o Перейти на вкладку материалов объекта; 

o Создать новый материал; 

o Добавить нод «Color -> MixRGB», в котором задать цвета, используемые для 

раскраски объекта (черный цвет маски соответствует Color1); 

o Добавить нод «Input -> Vertex Color», соединив его выход «Color» с входом 

«Factor» нода MixRGB; 

o В настройках нода Vertex Color выбрать ранее созданную в режиме Vertex 

Paint черно-белую маску. 

 

Настройка контактных теней другого цвета 

 

Позволяет имитировать вкрапления в местах неровностей типа щелей между досками или 

тротуарными плитками. 

Примечание: для рендер-движка Eevee следует предварительно включить настройку 

«Ambient Occlusion» 

 

Новые ноды, используемые при создании материала, и их краткое описание: 

 Input -> Ambient Occlusion – предназначен для выделения мест близкого контакта 

поверхностей. 

 

Алгоритм создания материала: 

 Перейти на вкладку материалов объекта; 

 Создать новый материал; 

 Добавить нод «Color -> MixRGB», в котором задать цвета (цвет теней – Color1), 

используемые для раскраски объекта (черный цвет маски соответствует Color1); 

 Добавить нод «Input -> Ambient Occlusion», соединив его выход Color или AO с 

входом Factor нода MixRGB. 

 

Основы использования текстур 

Понятие о текстурах и принципах их использования. Необходимость предварительного 

применения к объекту параметров Rotate и Scale. 

 

Нод «Texture -> Image Texture» и его настройки: 
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Кнопка со стрелкой вниз позволяет использовать в ноде уже 

существующую в проекте текстуру; 

Кнопка «New» позволяет создать новую текстуру; 

Кнопка «Open» позволяет найти файл текстуры и 

подключить его. 

 

 

При наличии UV-развертки объекта обычно используется 

настройка «Flat» (плоская), если развертки нет, то в 

зависимости от формы объекта могут использоваться 

настройки другие настройки. 

 

В настройке «Color Space» для основной текстуры обычно 

указывается «sRGB», для вспомогательных текстур 

(которые обычно бывают черно-белыми) указывается 

«nonColor». 

 

 

 Подключение нодов «Vector -> Mapping» и «Input -> Texture Coordinate» (Cntrl+T). 

 

 

Нод «Mapping» позволяет управлять 

положением текстуры на объекте, а также 

ее размером. 

 

За положение  текстуры на объекте 

отвечают разделы «Location» и «Rotation», 

за размер текстуры – раздел «Scale». 

 

В случае наличия UV-развертки для 

объекта в ноде «Texture Coordinate» 

следует использовать выход «UV», без 

наличия развертки обычно используется 

выход «Object». 
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Понятие о UV-развертке объекта (для примитивов создается автоматически). 

 

Автоматическое создание UV-развертки для объекта: 

 

 Разделить рабочее пространство на два окна, одно из окон перевести в режим «UV 

Editor»; 

 Выделить в другом окне объект, перейти в Edit Mode; 

 Выделить все грани объекта; 

 Нажать «U» и выбрать пункт «Smart UV Project»; 

 Автоматически созданная развертка отобразится в окне «UV Editor». 

 

Ручное создание UV-развертки: 

 

 Подготовить объект, создав линии разрезов: 

o Выделить объект, перейти в Edit Mode; 

o Выделить ребра по которым предполагается выполнить разрезы; 

o Выполнить правый щелчок мыши и выбрать «Mark Seam»; 

o Если требуется отказаться от разреза по какому-либо ребру, следует 

выделить его, щелкнуть правой кнопкой и выбрать «Clear Seam»; 

 Нажать «U» и выбрать «Unwrap»; 

 Развертка появится в окне «UV Editor». 

Текстурный материал состоит из текстур Diffuse, Ambient Occlusion, Roughness, 

Specularity, Normal и Bump: 

 

 Ambient Occlusion - предназначена для подчеркивания и усиления контактных теней. 

Текстура представляет собой черно-белый рисунок, который обычно в режиме 

Multiplay (можно и в других затемняющих режимах) накладывается на основную 

текстуру Diffuse; 

 Roughness – предназначена для усиления прорисовки шероховатости. Подключается в 

входу Roughness нода Principled BSDF; 

 Specularity – предназначена для усиления прорисовки блеска объекта на краях. 

Подключается в входу Specularity нода Principled BSDF  

 Normal - предназначена для усиления прорисовки наклонных неровностей объекта. 

Подключается к входу Normal нода Principled BSDF через нод «Vector -> Normal Map»; 

 Bump - предназначена для усиления прорисовки высоты неровностей объекта. 

Подключается к входу Normal нода Principled BSDF через нод «Vector -> Bump». 
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Примечание 1. В большинстве случаев текстура Roughness может быть получена из 

текстуры Specularity путем ее инвертирования (нод «Color -> Invert»). 

Примечание 2. В случае одновременного наличия текстур Normal и Bump они 

подключаются следующим образом:  

 выход Color текстуры Normal подключается к входу Color нода Normal Map; 

 выход Normal нода Normal Map подключается к входу Normal нода Bump; 

 выход Color текстуры Bump подключается к входу Height нода Bump; 

 выход Normal нода Bump подключается к входу Normal нода Principled BSDF. 

 

Создание «вспомогательных» текстур в программе CrazyBump. 

 

 Запустить программу «Crazy Bump»; 

 Открыть файл с изображением текстуры; 

 Программа предложит два варианта изображения, выбрать один из предложенных; 

 Программа создаст комплект текстур, их совместное действие можно просмотреть на 

объектах разной формы; 

 Сохранить комплект текстур. 

 

Нанесение готовых изображений поверх материала 

Область применения режима «Texture Paint» – нанесение готовых изображений 

(например, эмблем или логотипов) поверх уже существующего материала. 

 

Порядок операций: 

 Разделение окна программы на две области: в левой отображается Viewport в режиме 

«Material Preview», в правой – «UV Editor»; 
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 Создание нового пустого прозрачного изображения в правой области UV Editor (по 

сути, создание новой пустой прозрачной текстуры): 

o Нажать кнопку «New Image»; 

o Задать название новой текстуры; 

o Задать размеры новой текстуры (обычно 2048 на 2048 px); 

o Сделать текстуру прозрачной (нажать на поле цвета и в поле «A» установить 

нулевое значение); 

o Установить галочку «Alpha»; 

o В поле «Generated Type» оставить «Blank»; 

o Нажать кнопку «OK». 

Новая пустая прозрачная текстура создана и сейчас находится в оперативной памяти 

компьютера. Впоследствии ее следует сохранить на диск в графическом формате с 

поддержкой альфа-канала (прозрачности). 

 

Примечание 1. Новая пустая прозрачная текстура может быть создана заранее в 

любом графическом редакторе, например, в Photoshop. 

 

 Переход в правом окне в редактор материалов («Shader Editor»), добавление нового 

нода  «Texture -> Image Texture». Для нового нода «Image Texture» выбрать ранее 

созданную пустую прозрачную текстуру, пока хранящуюся в оперативной памяти. 

Подключить выход «Color» нода «Image Texture» с пустой текстурой напрямую к 

входу «Surface» нода «Material Output». 

 

Примечание 2. После выполнения описанных операций объект, к материалу которого 

добавляется изображение, станет полностью черным, поскольку сейчас на него 

нанесена пустая прозрачная текстура. Тем не менее, поскольку левое окно находится в 

режиме «Material Preview», контуры объекта видны, что поможет правильно 

позиционировать добавляемое изображение. 

 

 Переход в левом окне в режим «Texture Paint». В окне появится кисть, размер которой 

можно изменять, нажав клавишу «F», потянув мышь и щелкнув левой кнопкой, когда 

нужный размер кисти будет достигнут. 

 Настройка изображения для кисти: 

o Выбрать закладку «Настройка активного инструмента…»; 

o В поле «Mode» выбрать «Single Image»; 

o В поле «Выбор связываемого изображения» выбрать ранее созданную пустую 

текстуру; 

o Раскрыть пункт «Texture», в поле «Mapping» выбрать «Stensil»; 

o Нажать кнопку «New», указать имя текстуры; 

o Перейти на вкладку «Настройки текстур», в блоке «Image» нажать кнопку 

«Open» и выбрать файл с изображением, которое планируется наносить на 

объект (обычно какое-либо изображение на прозрачном фоне). Изображение 

должно появиться в окне предпросмотра; 

 

 Вернуться на вкладку «Настройка активного инструмента…», в блоке настроек 

«Texture» убедиться, что изображение для кисти успешно загрузилось. 
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 Навести курсор на левое окно (где отображается контур объекта). В окне должно 

появиться полупрозрачное изображение, которое предполагается нанести на объект. 

Изображение можно передвигать правой кнопкой мыши, масштабировать правой 

кнопкой мыши при нажатой кнопке «Shift», вращать правой кнопкой мыши при 

нажатой кнопке «Cntrl». 

 

 После завершения позиционирования изображения, следует установить размер кисти 

несколько большим, чем наносимое изображение, навести кисть поверх изображения, 

нажать левую кнопку и при нажатой кнопке немного поводить мышью поверх 

изображения. Изображение нанесено на объект (точнее, добавлено на ранее созданную 

пустую прозрачную текстуру). 

 

 В случае необходимости, можно снова позиционировать изображение (и сам объект, 

например, повернув его) и повторно его нанести на объект. Можно также сменить 

изображение кисти и нанести на объект новое изображение. 

 

 Сохранить прозрачную текстуру с нанесенными на нее изображениями, для чего в 

правом окне перейти в «UV Editor» и выполнить команду «Image -> Save» или «Image 

-> Save As…». 

 

Примечание 3. Если существуют несохраненные изменения прозрачной текстуры, в 

названии кнопки «Image» появится звездочка и надпись кнопки будет «Image*». 

 

 

 Подключить текстуру к материалу, поверх которого наносились изображения: 

o Перейти в правом окне в «Shader Editor»; 

o Добавить нод «Color -> MixRGB», 

o К входу «Color1» подключить ранее созданный материал; 

o К входу «Color2» подключить вновь созданную прозрачную текстуру с 

нанесенными на нее изображениями (выход «Color»); 

o К входу «Factor» нода «MixRGB» подключить выход «Alpha» прозрачной 

текстуры с нанесенными изображениями. 

 

Нанесение изображений поверх материала завершено. 

 

Создание «объемных» материалов 

Сфера применения нода «Shader -> Principled Volume» - создание областей тумана или 

дыма. 

 

Основные настройки нода «Shader -> Principled Volume»: 

 

 Color – цвет тумана в объеме; 

 Density – плотность тумана; 

 Emission – настройки свечения тумана. 
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Управление распределением тумана внутри области с использованием текстуры «Gradient 

Texture», подключенной к входу «Density». 

 

 
 

 Нод «Texture -> Gradient Texture» использован для создание сферического 

распределения тумана внутри объекта со снижением плотности от центра к 

границам объекта. 

 Ноды «Mapping» и «Texture Coordinate» используются для позиционирования 

тумана внутри объекта. 

 Нод «Converter -> Math» в режиме умножения используется для 

усиления/ослабления плотности тумана внутри объекта. 

 

Управление распределением цвета тумана внутри области с использованием текстуры, 

подключенной к входу «Color». 
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 Нод «Texture -> Noise Texture» используется для создания хаотичного распределения 

цвета внутри области тумана; 

 Ноды «Mapping» и «Texture Coordinate» используются для позиционирования 

цветовых областей внутри объекта. 

 Нод «Converter -> Color Ramp» обеспечивает цветовую гамму области тумана. 

 

Использование HDRI карт 

Подключение HDRI карты в окне «Shader Editor»: 

 

 Выбрать пункт «World» в выпадающем списке. В рабочей области отобразятся ноды 

«World Output» и «Background»; 

 Добавить нод «Texture -> Environment Texture», подключить его к входу «Color» 

нода «Background»; 

 Нажать кнопку «Open» и выбрать предварительно найденное HDRI изображение; 

 Подключить ноды «Mapping» и «Texture Coordinate» (Cntrl+T); 

 Ориентировать HDRI карты относительно сцены. 

 

Блок «Рендеринг» 

Создание и настройка камер 

Создание камеры - «Shift+A -> Camera». 

Позиционирование камеры - использование настройки «Camera to View» 

дополнительного меню. 

Переключение на вид из камеры - «0» на Numpad. 

Настройка соотношения сторон и размера изображения из камеры - «Настройки вывода 

файлов -> Resolution». 
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Типы камер: перспективная и ортогональная - «Настройки данных объекта -> Type». 

 

Основные настройки ортографической камеры: 

 Orthographic Scale – удаление/приближение камеры; 

 Depth of Field -> Focus Distance – настройка фокусного расстояния, размывает 

объекты, находящее далее установленного в этом параметре значения; 

 Depth of Field -> Aperture -> F-Stop – аналог установки диафрагмы, при снижении 

значения снижается четкость всего изображения. 

 Viewport Display -> Passepartout – снижает япкость части сцены, не попавшей в 

камеру. 

 

Отличия в настройке перспективной камеры: 

 Focal Length – фокусное расстояние камеры, используется для приближения/удаления 

сцены. 

 

Создание и настройка источников света 

Создание источника света - «Shift+A -> Light». 

Позиционирование источника света выполняется стандартными командами перемещения 

и вращения.  

Типы источников света: Point, Sun, Spot, Area (точечный, солнце, пятно, светящаяся 

область). 

Общие принципы установки источников света для освещения сцены. Типы освещения: 

заполняющий, рисующий, моделирующий, контровой, фоновый свет. 

Назначение каждого типа источников света. Использование источников разных типов для 

создания заполняющего света, направленных световых пятен и точечных источников для 

рисующего и моделирующего света, светящихся областей для контрового и фонового света. 

 

Основные настройки источников света: 

 Power – мощность источника света; 

 Color – цвет источника света; 

 Специфичные для типа источника настройки. 

 

Рендер-движки Blender 3D 

Все настройки рендер-движков сосредоточены на кладке «Настройки рендера» 

 
Настройки рендер-движка Eevee: 

 

 Выбрать «Eevee» в поле «Render Engine»; 

 Sampling – группа настроек количества проходов при рендере (чем больше – тем 

качественнее рендер). Параметры группы: 

o Render - определяет количество проходов при финальном рендере; 

o Viewport - определяет количество проходов при отображении сцены в процессе 

работы. 
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 Ambient Occlision – группа настроек контактных теней (подключаемая, по умолчанию 

выключена). Параметры группы: 

o Factor – определяет контрастность контактных теней; 

o Distance – определяет размер теней; 

o Bounces Approximation – определяет наличие теней на обоих контактирующих 

поверхностях. 

 Bloom – группа настроек ореолов для светящихся поверхностей (подключаемая, по 

умолчанию выключена). Параметры группы: 

o Threshold – определяет порог светимости, при превышении которого создается 

ореол для поверхности; 

o Radius – определяет размер ореола; 

o Color – позволяет задать цвет ореола; 

o Intensity – задает интенсивность свечения ореола; 

 Color Management – группа настроек для определения типа контрастности сцены. Для 

курса оптимальными являются настройки по умолчанию (sRGB, Filmic, Medium 

Contrast), для повышения контраста могут быть установлены значения «Medium High 

Contrast» или «High Contrast». 

 

Настройки рендер-движка Cycles: 

 

 Выбор рендер-движка Cycles: 

o Выбрать « Cycles » в поле «Render Engine»; 

o Выбрать «Supported» в поле «Feature Set»; 

o Выбрать «GPU Compute» в поле «Device», если компьютер оснащен мощной 

видеокартой, которая опознается в настройках «Blender Prefences -> System -> 

CUDA» или «Blender Prefences -> System -> OpenCL». 

 Sampling – группа настроек количества проходов при рендере, настройки аналогичны 

настройкам для Eevee. Оптимальное количество проходов для рендера 250 – 300.  

 Настройки групп «Ambient Occlusion» и «Bloom» отсутствуют, Cycles просчитывает 

эти параметры по умолчанию; 

 Настройки группы «Color Management» аналогичны тем же настройкам в Eevee; 

 

Настройка шумоподавления в Cycles: 

 Включить шумоподавление – установить галочку «Настройки слоя визуализации –> 

Passes -> Data -> Denoising Data»; 

 Перейти в одном из окон программы в режим «Compositor», установить галочку «Use 

Nodes»; 

 Добавить нод фильтра «Denoise» между нодами «Render Layers» и «Composite»; 

 Добавить следующие подключения между нодами «Render Layers» и «Denoise»: 

o Noisy Image -> Image; 

o Denoising Normal -> Normal; 

o Denoising Albedo -> Albedo. 

Проверить наличие галочки «Настройки вывода файлов -> Post Processing -> 

Compositing» (она должна быть установлена). 
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Приложение 2.  

Перечень практических работ по курсу «Основы 3D моделирования» 

Практические работы блока «Моделирование» 

 
Получение, установка и предварительная настройка программы "Blender 3D". 

 

Практическая работа 1.1. Установка программы «Blender 3D» на компьютер и 

выполнение первоначальных настроек программы. 

  

  

 

 

Интерфейс программы "Blender 3D". Базовые понятия и элементы "Blender 3D" 

 

Практическая работа 2.1. Освоение базовых операций управления сценой в программе 

«Blender 3D». Управление 3D-курсором и Origin Point объектов. 

 

 

Работа с объектами в Object Mode 
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Практическая работа 3.1. Моделирование 

снеговика. 

 

 

 

Практическая работа 3.2. Моделирование 

ветряного генератора. 

  

 

Практическая работа 3.3. Моделирование 

ракеты. 

  

 

Практическая работа 3.4. Моделирование 

космической станции. 

   

Практическая работа 3.5. Моделирование 

летающей тарелки. 

   

Практическая работа 3.6. Моделирование 

бильярдного стола без луз с установленной 

пирамидой шаров. 

  

 

 

 

Редактирование объектов в Edit Mode 

 

Практическая работа 4.1. Моделирование 

простого домика. 
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Практическая работа 4.2. Моделирование 

шестеренки. 

   

Практическая работа 4.3. Моделирование 

катушки из заготовки. 

  

 

Практическая работа 4.4. Моделирование 

обезьянки с рожками. 

  

 

Практическая работа 4.5. Восстановление 

геометрии куба. 

   

Практическая работа 4.6. Проредить в два 

раза геометрию куба. 

   

Практическая работа 4.7. Сформировать 

из одного объекта из 9-ти кубиков три объекта 

по три кубика 

 
  

Практическая работа 4.8. Моделирование 

чайной чашки. 

  

 

Практическая работа 4.9. Доработка 

бильярдного стола: добавление луз, наклона 

бортов, придание конусообразности кию. 

 
 

 

 

 

Редактирование объектов в Edit Mode с использованием инструментов 
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Практическая работа 5.1. Моделирование 

арки моста. 

  

 

Практическая работа 5.2. Моделирование 

фрагмента крепостной стены с зубцами. 

  

 

Практическая работа 5.3. Моделирование 

домика с окнами и трубой. 

 

 

 

Практическая работа 5.4. Моделирование 

вазы по чертежу. 

 

 

 

Практическая работа 5.5. Моделирование 

сушилки-змеевика для ванны. 

  

 

Практическая работа 5.6. Моделирование 

домика с нависающей крышей. 
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Практическая работа 5.7. Сглаживание 

ребер у домика, смоделированного в 

предыдущем задании 5.6. 

 

 

 

Практическая работа 5.8. Моделирование 

летающей тарелки единым объектом. 

   

Практическая работа 5.9. Моделирование 

коровы. 

   

Практическая работа 5.10. 

Моделирование грузовика. 

  

 

 

 

Модификаторы и их использование 

 

Практическая работа 6.1. Настройка 

скругления для ребер грузовика, 

смоделированного в практическом задании 

5.10. 

 

 

 

Практическая работа 6.2. Моделирование 

сруба домика. Для исходного бревна 

инструментом «Loop» добавить 

дополнительную геометрию. 
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Практическая работа 6.3. Добавление 

досок к срубу сруб домика. Для исходной 

доски инструментом «Loop» добавить 

дополнительную геометрию. Обрезать доски 

инструментом «Knife». 

 

 

 

Практическая работа 6.4. Моделирование 

настила крыши. При выполнении этого 

задания следует также использовать 

инструменты разделения геометрии и 

скольжения. 

 

 

 

Практическая работа 6.5. Моделирование 

черепицы на крыше. В этом задании также 

следует дважды использовать модификатор 

«Array» и однократно «Mirror». 

 

 

 

Практическая работа 6.6. Придание 

реалистичности бревнам сруба. 

Практическая работа 6.7. Придание 

реалистичности доскам и черепице. 

 

 

 

Практическая работа 6.8. Моделирование 

произвольной неровной поверхности с 

возвышенностями и впадинами вокруг дома с 

использованием Weight Paint. 

 

 

 

Практическая работа 6.9. Моделирование 

и установка в домик окон и двери. Дверь 

смоделировать вручную, окна – с 

использованием Add-on Archimesh. 
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Практическая работа 6.10. 

Моделирование бордюра вокруг сценки с 

домом. 

 
 

 

Практическая работа 6.11. 

Моделирование колодца в сценке с домом. 

  

 

 

 

 
Системы частиц 

 
Практическая работа 7.1. Моделирование 

еловой ветки. 

 

 

Практическая работа 7.2. Моделирование 

фрагмента аллеи. 

 

 

Практическая работа 7.3. Моделирование 

травы в сценке с домом. 

 

 

 

Завершение моделирования сцены. 
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Практическая работа 8.1. Моделирование 

дорожки из плитки от дома к колодцу и 

площадку для летающей тарелки. 

 

 

Практическая работа 8.2. Моделирование 

летающей тарелки и расположение ее на 

площадке. 

 

 

Практическая работа 8.3. Моделирование 

деревьев и расположение их вокруг дома. 

 

 

Практическая работа 8.4. Моделирование 

спутниковой антенны для дома. 

 

 

Практическая работа 8.5. Моделирование 

фонариков и расположение их по краю 

территории вокруг дома. 

 

 

 
 

Практические работы блока «Текстурирование» 
 

Предварительная подготовка к текстурированию 
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Практическая работа 9.1. Настройка 

среды для выполнения простого 

текстурирования. 

 
 

 
Создание простых материалов и присвоение их объекту 

 

Практическая работа 10.1. Создание материалов и присвоение их объектам 

сцены:  

 фонари (отработать применение разных 

материалов к разным частям объекта); 

 

 

 летающую тарелку (металлический 

корпус, стеклянные купол и ободок 

тарелки, светящиеся углубления); 

 

 

 деревья (зеленая крона, коричневый 

ствол). Слегка видоизменять цвета от 

дерева к дереву. 

 

 

 окна дома (белая слегка светящаяся 

основа, слегка желтые светящиеся 

стекла). Цвет стекол можно немного 

изменять от окна к окну. 
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Создание простых процедурных материалов 

 
Практическая работа 11.1. Присвоение 

коровам пятнистых материалов. 

 

 

Практическая работа 11.2. Раскраска в 

вариативные цвета бордюра, колодца и 

черепицы дома. 

 

 

 

 

Практическая работа 11.3. Попробовать 

имитировать цветные вкрапления (создать 

имитацию гранита) в блоках бордюра. 

 

 

Практическая работа 11.4. Раскраска 

поверхности земли вокруг дома: в зеленый 

цвет - в месте расположения травы, в 

коричневый - вблизи дорожек и бордюра. 
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Практическая работа 11.5. Создание 

материала для двери дома с имитацией  

запыленности в щелях. Создание материала 

для плитки дорожки с имитацией проросшей 

травы между стыками. 

 
 

 

 

 

 

 
Основы использования текстур 

 
Практическая работа 12.1. Наложение 

текстур на бревна и доски домика. 

 

 

 

Нанесение готовых изображений поверх материала 

Практическая работа 13.1. Нанести 

изображение стикера на дверь дома. 
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Создание «объемных» материалов 

 
Практическая работа 14.1. Добавление 

тумана в сцену с домиком. Применение 

управления распределением цвета и плотности 

тумана. 

 
 

 

Использование HDRI карт 

 
Практическая работа 15.1. Создание фона 

сцены с использованием HDRI карты. 

 

 

 

Практические работы блока «Рендеринг» 
 

Создание и настройка камер 

 
Практическая работа 16.1. Создание и 

настройка ортогональной камеры для 

отображения сцены. 

 
 

 

Создание и настройка источников света 

 

Практическая работа 17.1. Создание и 

настройка источников света для сцены. 
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Рендер-движки Blender 3D 

 
Практическая работа 18.1. Настройка 

рендер-движка Eevee и выполнение 

финального рендера сцены. 

 

 

 

 
 

Результат рендера с использованием Eevee 

 

Практическая работа 18.2. 

Настройка рендер-движка Cycles, 

шумоподавления и выполнение 

финального рендера сцены. 
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Результат рендера с использованием Cycles без шумоподавления 

 

 
 

Результат рендера с использованием Cycles с шумоподавлением 
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Приложение 3.  

Примеры оценочных материалов по курсу «Основы 3D моделирования». 

Примеры тестовых вопросов. 

1. Расставьте номера элементов интерфейса программы Blender 3D. 

1 2

3

4

5

 

Наименование элемента интерфейса Номер на рисунке 
Элемент настройки типа используемых координат объекта  

Кнопка включения и настройки инструмента «Магнит»  

Элемент выбора режима обработки выделенного объекта  

Панель инструментов в режиме «Edit Mode»  

Кнопки выбора режима работы Viewport  

 

2. Какие из перечисленных команд не приведут к масштабированию объекта? 
 

 RX45 

 S 

 S0.5 

 Cntrl+R 

 S(Shift+Z) 

 GZ2 
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3. Вам необходимо точно отразить объект относительно какого-либо другого 

объекта. Как вы это сделаете? 
 

 Использую модификатор «Array» 

 Использую инструмент «Магнит» 

 Использую команду дублирования объекта Shift+D и постараюсь 

максимально точно позиционировать дубликат 
 Использую модификатор «Mirror» 

 4. Вам необходимо нанести на объект изображение стикера, которое 

содержится в графическом файле с расширением .png. Каким инструментарием 

«Blender 3D» Вы воспользуетесь? 
 

 Использую подключение файла с изображением к параметру «Base Color» нода 

«Principled BSDF»  

 Использую инструментарий режима «Texture Paint», создам дополнительную 

прозрачную текстуру с изображением стикера, после чего добавлю созданную 

текстуру к материалу объекта с использованием нода «MixRGB». 

 Использую инструментарий режима «Weight Paint» для создания карты весов, 

после чего использую созданную карту весов в модификаторе «Displace» 

 Использую изображение со стикером в качестве HDRI карты. 

 

5. Вам необходимо понизить уровень шума на финальном изображении 

смоделированной Вами сцены. Какую технологию Вы используете? 
 

 Модификаторы 

 UV-развертку всех объектов сцены 

 Шумоподавление 

 Системы частиц 

 

Пример практического задания. 

Смоделировать летающую тарелку. Модель должна быть единым объектом: 
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Последовательность моделирования: 

 

Создание примитива «цилиндр». 
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Масштабирование цилиндра по оси «Z». 

 

Переход в «Edit Mode». 
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Применение инструмента «Inset». 

 

Придание объекту формы летающей тарелки. 
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Моделирование кабины с использованием инструмента «Extrude». 

 

Скругление кабины с использованием инструмента «Bevel». 
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Моделирование сопла с использованием инструментов «Inset» и «Extrude». 

 

Создание петель для моделирования опор. 
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Перемещение петель с использованием инструмента «Slider». 

 

Выдавливание опор с использованием инструмента «Extrude» в режиме выдавливания 

вдоль нормалей. 

 

 

 

 

 

 


